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Abstract 

A coating die is used for distributing liquid in order to apply a uniform film on a solid surface. 

The fluid flowing through the die cavity can exert a pressure of up to 500,000 Pascal on the die 

body. This liquid pressure can distort the die and lead to a non-uniform slot opening, which in 

turn causes non-uniformity in the coating thickness. Distortion of the die can also occur during 

non-isothermal operation of the die; this is an undesired consequence of delivering liquids at a 

different temperature than the die itself. The distortions undergone by the die both due to liquid 

pressure and non-isothermal conditions should be within the manufacturing tolerances for the 

slot heights in order to maintain uniformity in the coating. 

The deformation exhibited by a coating die due to pressure loadings is modeled both two-

dimensionally and three-dimensionally. A two-dimensional model has lower computational load 

and is preferred for die design. For the two-dimensional analysis of a coating die, the finite 

element method is used to determine the deflections due to pressure loadings with a focus on slot 

heights. A model of low computational load is also developed based on beam theory, and its 

results are compared with those of the two-dimensional finite element analyses predictions. The 

beam model is incorporated in a die design and simulation program in which flow and slot 

deformations are coupled. Two-dimensional finite element analyses due to non-isothermal 

conditions are also performed on the coating die to give an estimate of the die deflection due to 

temperature variations within the die. A three-dimensional coating die with varying inner cavity 

area is modeled and analyzed to check its predictions with those of the two-dimensional finite 

element analyses and beam theory results. 

In the literature reviewed, flow distribution is fully coupled to die deformation only for extrusion 

dies. Extrusion dies are used for extruding melted polymers of very high viscosity. Therefore, the 

deflections are much larger for extrusion dies than for coating dies. Mechanical adjustments can 

be used to manage the large deflections in the case of extrusion dies whereas coating dies have to 

be designed for small deflections comparable to manufacturing tolerances. This is the first time 

where a coupled analysis has been done for a coating die. This research provides the slot 

deflections for a coating die subjected to pressure loadings that vary throughout the die length. 

The model of flow distribution coupled with die distortion incurs low computational load and is 
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intended for use in design and simulation programs. Die design guidelines are developed based 

on examination of the die dimensions and flow parameters having the greatest effect on slot 

deflections. 
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Nomenclature 

 ̅ = Cross sectional area of the inner cavity 

A = Cross sectional area of the outer cavity 

Ac = Cross sectional area of the cylindrical pipe 

a = Dimensionless variable for inner cavity area 

b = Width of flat surface of the outer cavity 

di = Inner cavity depth 

do = Outer cavity depth  

E = Young’s Modulus of Elasticity  

  ̃ = Local resultant force vector 

f = Dimensionless variable for volumetric flow rate in inner cavity 

g = Dimensionless variable for volumetric flow rate in outer cavity 

 ̅ = Dimensionless variable for inner slot height 

H’ = Dimensionless variable for outer slot height 

< ̅> = Undistorted inner slot height 

<h> = Undistorted outer slot height 

 ̅’ = Distorted inner slot height 

h’ = Distorted outer slot height 

 ̅ ’ = Distorted height at the middle of inner slot 

hm’ = Distorted height at the middle of outer slot 

I = Moment of inertia 
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 ̃ = Unit vector in the x direction 

 ̃ = Unit vector in the y direction 

 ̃ = Unit vector in the z direction 

L = Cavity length 

li = Width of the inner slot 

lo = Width of the outer slot 

Mi = Local bending moment 

 ̃  =Unit vector normal to the contracting surface 

 ̃  =Unit vector normal to the elevating surface 

 ̅ = Inner cavity and slot pressure 

P = Outer cavity and slot pressure 

 ̅  = Characteristic inner cavity and slot pressure 

   = Characteristic outer cavity and slot pressure  

p = Pressure  

 ̅ = Volumetric flow rate in the inner cavity 

Q = Volumetric flow rate in the outer cavity  

q = Flow rate per unit width 

<q> = Flow rate per unit width (perfect flow) 

r = Dimensionless slot group 

 ̃  = Local resultant vector between the resultant force vector and the centroid of the beam 

s = Dimensionless outer cavity group 
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T = Local thickness 

To = Original thickness of the die  

u = Velocity of the fluid 

Wi  = Width of the inner cavity 

Wo = Width of the outer cavity 

x1 = Length from origin to section 1 

x2 = Length from origin to section 2 

x3 = Length from origin to section 3 

x4 = Length from origin to section 4 

x5 = Length from origin to section 5 

Z = Sectional cavity length 

ε = Dimensionless inner cavity group 

 
  

  
 = Pressure gradient 

μ = Viscosity 

ν = Poisson’s ratio 

 ̅ = Shape factor of the inner cavity 

λ = Shape factor of the outer cavity 

λc = Shape factor of the cylindrical pipe 

 c = Contraction angle  

 e = Elevation angle  

ξ Dimensionless variable for cavity length 
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Chapter 1  

I. Background 

In the manufacturing process of mainly polymeric film or sheet products, coating dies are 

used for distributing a polymer dissolved in a solvent often with dispersed particles, in 

order to apply a uniform film over a solid surface. The liquid distribution geometry 

consists of one or two cavities running through the length of each bar (as shown in Figure 

1.2) and one or two narrow slots that create high pressures in the inner cavity (referred to 

as back pressure). The width of the die (in the direction towards the slot exit of Figure 

1.2) taken up by the cavities and slots is called the working width (Figure 1.3). 

Dies may distribute more than one liquid for the purpose of coating several layers 

simultaneously. In that case several bars are bolted or clamped together to form a stack 

(Figure 1.1). A bar in a stack is in contact with pressurized liquid on both sides. 

 

Figure 1.1: Side View of a Two Layered Coating Die 



2 

 

The liquid entering the die inlet flows along the length of the inner cavity (Figure 1.2). 

This is accomplished by choosing a cavity with a large cross-sectional area, which creates 

lower resistance to flow in comparison with that created by the small height of the inner 

slot. The inner cavity may become smaller near the ends of the die to avoid fluid flow 

stagnation, and it is often the case that the working width gradually decreases as well to 

improve performance over a range of fluid types. Flow stagnation near the cavity ends 

can lead to several problems including sedimentation of dispersed particulate, inefficient 

purging of the coating composition with solvent, and solidification of the coating 

composition due to a cross linking chemical reaction or to structure that can build in the 

liquid at low shear rates. Slot heights are on the order of 200 microns and may be 

manufactured to  0.5 micron. The outer cavity and slot combination is added to 

minimize the effect of slot mechanical tolerances and to increase the die’s ability to 

uniformly deliver liquids with differing in rheology. The outer cavity also improves the 

flow distribution from the inner slot. The die can be regarded as a stack of bars made of 

high grade stainless steel having working width around 100 mm, thickness around 30 mm 

and die length of the order of 4 meters. 

The fluid flowing through the die cavity can exert a pressure of up to 500,000 Pascal on 

the die body which can distort the die leading to non-uniform slot heights. Distortion of 

the die can also occur if liquids are delivered at a temperature different than the die itself 

which is maintained by water passages. The best practice to decrease the deformation of 

the die is to keep the coating die in the isothermal condition which does not always 

happen in practice. The distortions undergone by the die both due to liquid pressure and 

non-isothermal conditions should be within the manufacturing tolerances for the slot 

heights in order to maintain uniformity in the coating. 

II. Die Design Fundamentals 

The design of dies is complicated by disparate length scales. The cavity width and depth 

may be 100 times larger than the slot height, and the cavity length may be 100 or more 

times the cavity width and depth. The dimensions of the die and the design of the liquid 

passages need to be such that distortions due to pressure loading have negligible effect on 
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the flow distribution. Thermal distortions place a limit on temperature variations as well. 

 

Figure 1.2: Front Section View of Coating Die 

 

Figure 1.3: Side View of a Coating Die 

Flow models are used that take advantage of the disparate length scales to simplify the 

governing equations. On the other hand, full finite element models have difficulty coping 

with the vast variation of length scales and are not suited to optimization routines. For 

design purposes, flow models are not coupled to pressure and thermal distortions, which 

are separately estimated and presumed negligible. However, flow may be coupled for 

simulation of a given design. Flow distribution is particularly sensitive to variations in the 
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height of the outer slot. Flow distribution is much less sensitive to variations in the height 

of the inner slot due to the dampening ability of the outer cavity on flow variations across 

the die length. A major benefit of a two cavity die is that the outer slot height can be 

larger than the inner slot height. 

A coating die consisting of a tapered inner cavity is referred to as a coat-hanger shaped 

die and the one without taper is referred to as a T-shaped die. The outer cavity is added to 

dampen the flow rate variation leading to flow uniformity at the exit. The shape and 

aspect ratio of both the inner and outer cavities are kept constant throughout the analysis 

but their sizes can vary. Constant geometric cavity shapes simplifies the computation of 

pressure losses through what is called a shape factor. The smaller the shape factor, the 

higher the pressure gradient. A circular shape has the smallest shape factor. Typically, 

however, the inner cavity has a rectangular shape and the outer cavity a triangular or 

trapezoidal shape with some rounding at corners. The shape factor for the rectangular 

inner cavity and the trapezoidal outer cavity are less than the shape factor obtained for a 

circular cross section as derived in Appendix C1. The shape factors for the particular 

inner and outer cavities used in this work are estimated to be 0.02854 and 0.019949 

respectively from a shape factor computation analysis by Dr. Steven Weinstein (private 

communication). The inner cavity is rectangular with an aspect ratio of 0.8, which is 

maintained constant as the area tapers gradually along the die length from the center 

towards the end. The outer cavity is trapezoidal with an expansion angle of 30
o
 and 

contraction angle of 60
o
, and its aspect ratio is 0.25. 

Dies for the simultaneous coating of several layers consist of a stack of bars (as shown in 

Figure 1.1). In that case, both sides of the bars are in contact with pressurized liquid, and 

as a result the pressure that produces distortion for interior bars is partially cancelled. 
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Chapter 2  

I. Literature Review 

An important requirement in the design of dies is to achieve a uniform flow rate across 

the die exit. This is possible by keeping the distortion within the mechanical tolerance to 

which the die was manufactured at great expense (slot height or slot surface flatness 

measurements guide hand lapping of the slot surfaces). All of the literature reviewed 

couples die distortion and flow models to predict flow uniformity only for extrusion dies. 

Extrusion dies distribute melted polymer and operate at much higher pressures where 

significant slot deflections always occur that are called clamshelling because of the 

opening of the slots. Where coupled analysis has been done, it has been iterative: flow 

and distortion analyses are done separately and in sequence until convergence (successive 

approximations). Earliest work by Pearson (1964) uses beam theory to calculate the bar 

distortion due to pressure and temperature variation of a flat-film extrusion die. Design 

guidelines for minimizing the clamshelling effect for extrusion dies have been proposed 

by Helmy (1988). Work on numerical simulation of slit die performance was reviewed by 

Sander and Pittman (1996). In this paper the interaction of melt flow and die body 

deflection was taken into account in a fully coupled analysis, and predictions were 

confirmed in experiments on a 1.2m wide high pressure die. Melt flow was treated using 

the Hele-Shaw approximation, and the die deflection using Mindlin thick plate theory, 

reducing both analyses to two dimensions with low computational load. Subsequently, 

Gifford (1997) developed a coupled analysis using three dimensional finite elements. 

Comparisons with two dimensional analyses or experimental results were not presented 

so the advantages provided by this significantly larger computation are unclear. However, 

Pittman et al. (1995) together with coupling the flow analysis with three-dimensional 

finite element model, also compared the coupling analysis with experimental results. 

Sienz et al., (2006), and Wang and Smith, (2007), use the coupled analysis to carry out an 

optimization routine which computes the optimal design parameters for an extrusion die 

keeping the distortions minimum. Secor (1997) discusses the flow distribution through 

internal cavities of a coating die based only on an approximate flow model; however it 

does not consider the effect of die deformation on the fluid flow distribution. Similarly 
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CFD analysis of flow in coating dies has been done by Lee, Wen and Liu (1989 and 

1990) but die deformations were not considered. 

II. Goal of the Research 

Most of the research done so far on die deformation has been only on extrusion dies. An 

extrusion die is used for extruding polymer melts of very high viscosity, whereas a 

coating die is used for coating polymer dissolved in a solvent with viscosity less than 1 

Pa-sec. The internal fluid pressures involved in the case of extrusion die is much higher 

than that of the coating die which results in the extrusion die distortion being greater than 

the distortion undergone by the coating die and typically a significant fraction of the 

undistorted slot height. In the case of extrusion dies mechanical die lip adjusters or 

choker bars can be used to correct or compensate for the distortion which aids in reducing 

non uniformity. These adjustments are absent in case of coating dies and hence their 

performance is limited by the fabrication tolerances to deliver very high uniformity. The 

main focus of this research is to estimate the slot distortion of a coating due to pressure 

and non-isothermal loadings. Die deflection can change the internal dimensions of a die 

which leads to alterations in the flow resulting in non uniform coating thickness. Hence 

the die needs to be designed so as to keep the deflection within the fabrication tolerances, 

and the uniformity in the flow is not affected. However, end users may use the die under 

conditions for which it was not designed, and as a result what happens to flow 

distribution when die deforms is of interest. 
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Chapter 3  

I. Introduction 

This chapter discusses the one-dimensional analysis of the coating die bar using beam 

theory and two-dimensional analysis of the bar using finite element method. The coating 

die is divided into cross-sections along the length of the bar to carry out the analyses. 

Each section is modeled as a beam cantilevered at the inner cavity edge and analyzed for 

deflection using beam theory. The beam theory results are compared with two-

dimensional finite element analysis predictions obtained using ANSYS in plane strain 

condition. The beam theory and finite element analysis results are further compared with 

the three-dimensional finite element analysis predictions. This chapter also explains the 

two-dimensional thermal analyses performed on the die which gives an upper limit for 

temperature variations that can take place within a coating die. 

II. One-Dimensional Analysis using Beam Theory 

Estimation of slot distortion of the coating die due to pressure loading is evaluated by 

cross-sectioning the three-dimensional coating die along its length to obtain a beam with 

height To, width W and unit thickness. The beam is cantilevered at one end and subjected 

to pressure loading as shown in figure 3.1. The pressure distribution in the inner and 

outer cavity is constant and of the order of 500,000 and 100,000 Pascal respectively. The 

pressure loading in the inner cavity affects not only the bottom of the cavity but also its 

sides. There is a linear decrease in pressure along the width of the slots. The pressure in 

the inner slot decreases linearly from 500,000 to 100,000 Pascal and the pressure in the 

outer slot varies linearly from 100,000 to 0 Pascal along its width. The cantilevered beam 

is divided into six sections and each section is further divided at regular intervals for 

numerical computation, and the bending moment at the nodes in each section due to the 

applied pressure is calculated as shown in Appendix A. The Euler-Bernoulli beam 

equation which relates the bending moment to beam deflection and stiffness is used to 

obtain the deflection of the two dimensional coating die. 
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Figure 3.1: One-Dimensional Deflection Analysis using Beam Theory 

The bending moments at each section is given by, 

      ̃  ( ̃     ̃ )  (3.1) 

in which the force is computed from the pressure loading. The results obtained using the 

above equation are substituted into the Euler Bernoulli beam equation given below, 

   
    

   
      (3.2) 

Beams which are wide compared to their thickness cannot expand and contract laterally 

as much as narrow beams. This results in an increased equivalent stiffness, 

   
     

    
  (3.3) 

The moment of inertia of a rectangular beam is, 

   
   

 

  
  (3.4) 

Using the cantilevered boundary conditions,    , 
   

  
   and the trapezoidal rule for 

the integrations, the slope and the deflection of the beam at the nodes in each section is 

determined. 

P

do di
To

Wo

lo b li Wi

x

y

Θc Θe

i 

    

(1)

(2)

(3)

(4)
(5)

(6)
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The deflections at any point across the width of the die can be obtained in a similar way 

with the help of a simulation program developed using the beam theory equations (as 

shown in Appendix A) in Microsoft Excel. The beam modeled is programmed in a single 

worksheet where the lengthwise coordinate is an input. Excel’s data table macro is then 

used to extract results for any specified number of coordinate values. The data table 

automatically updates the worksheet at each coordinate value and extracts the results of 

interest. 

In the design of the coating die it is essential to keep the slot heights within the 

fabrication tolerances to avoid alterations in the flow which result in non uniformity in 

the coating thickness. In order to couple the flow with the deflection of the slots, the 

deformation undergone by the slots is assumed to be linear along their widths. The 

assumption of linear variation was checked with ANSYS calculations and found to be 

reasonable. 

As a result of linear elasticity, the deflection at the center of the inner slot is given by, 

  ̅    ̅ ̅      (3.5) 

Similarly the average deflection at the center of the outer slot is given by, 

   
   ̅ ̅     (3.6) 

The coefficients  ̅,  ,  ̅,   used to estimate the average inner and outer slot deflections 

along the length of the coating die are obtained using the data table function in Excel 

from the beam theory calculations. These coefficients depend upon the length coordinate, 

and so they must be computed at each of the 26 nodes used to discretize the half length of 

the bar. Only one half of the bar is analyzed due to symmetry. 

III. Deflection Coupled with Flow Analysis 

Die deflection can drastically change the slot heights of a die and can alter the flow 

resulting in non-uniformity in the coating thickness. Hence it is essential to couple the 

deflection model with the flow model to estimate the deflection at the middle of the slots, 

back pressure in the cavities, and flow rate variations within the slots. 
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The deflection and flow coupled equations for inner and outer cavities are derived by 

combining the continuity equations of inner and outer slots and cavities (Appendix C2) 

and the equation of flow in the cavities with the linearized pressure equations of the inner 

and outer slots as seen in Appendices C3 and C4 respectively. The coupled equations are 

linearized about perfect flow distribution and undeformed slots since departures of no 

more than a few percent are of interest. So, it is a departure from perfect flow distribution 

that is computed. Linear equations avoid iterative solution. The coupled dimensionless 

equations for the inner and outer slot are derived from the average slot deflection 

equations (3.5 and 3.6) as described in Appendix E. 

As the coupled analysis has many parameters, it is convenient to use dimensionless 

coordinates, variables and groups of parameters (Appendix D1). The coupled equations 

are in dimensionless form. There are four primary variables: departures from perfect flow 

distribution in the inner and outer cavities, and departures from perfect slot heights. The 

four equations given below are from equations (D.37), (D.41), (E.12), and (E.14) derived 

in Appendices D and E. 

Coupled dimensionless equation for inner slot, 

 ̅ *   
 ̅ ̅ 

  ̅ 
+  

 ( ̅  )   
 

  ̅ 
 

( ̅  )  

  ̅ 

   

  
 *

 ̅ ̅ 

  ̅ 
 

( ̅  )  

  ̅ 
+
   

  
 

( ̅  )

  ̅ 
   

 ̅

  ̅ 
 ̅  (3.7) 

Coupled dimensionless equation for outer slot, 

  *   
( ̅  )  

   
+  

  ̅ ̅  ̅
 

   
 

( ̅  )  

   

   

  
 *

 ̅ ̅ 

   
 

( ̅  )  

   
+
   

  
 

( ̅  )

   
   

 ̅

   
 ̅  (3.8) 

Coupled dimensionless equation for inner cavity, 

  
 [(   )   ]

  
      

    

   
[    ̅ ]   

  ̅ 

  
    (3.9) 

Coupled dimensionless equation for outer cavity, 

 
    

   
 

    

   
  

   

  
       (3.10) 
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 ̅ ,    are the dimensionless variables for inner and outer slot height deflection at the 

center,   ,    are the dimensionless variables for the volumetric flow rates in the inner and 

outer cavities and ε, s, r are the dimensionless groups for inner cavity, outer cavity and 

slots respectively. The prime marks indicate that the slot height variations are fractions of 

the perfect slot height and the flow rates are fractional departures from perfect flow. Note 

that the equations for outer and inner cavities are coupled. In other words, the flow 

variation in the inner cavity effects the flow variation in the outer cavity. The coating die 

is divided into 26 nodes along the length of the die and the coupled dimensionless 

equations are solved simultaneously in Excel using the boundary condition of f’ and g’ is 

equal to 0 at the center and end of the die. The dimensionless variables obtained by 

solving the equations are used to compute results such as average slot deflections at the 

center, back pressures and flow rate variations. An advantage of spreadsheet 

implementation is that the equations are instantly resolved whenever an input value is 

changed. 

IV. Two-Dimensional Finite Element Analysis due to Pressure Loading 

Two-dimensional finite element analyses are carried out in order to compare their 

predictions with the results obtained by beam theory and also with the three-dimensional 

finite element analysis results. The model of the die is cantilevered and subjected to 

pressure loadings to determine the maximum deflection at the slot exit through finite 

element analysis as explained in Appendix F. The inner cavity pressure is kept constant at 

a value of 500,000 Pascal and it is applied to the bottom as well as to the inner cavity 

sides. The pressure distribution in the inner slot is linearly varied from 500,000 to 

100,000 Pascal. The outer cavity is subjected to a uniform pressure loading of 100,000 

Pascal. The outer slot pressure is decreased from 100,000 Pascal to no pressure at the slot 

exit.  These pressure values are arbitrary for the purpose of comparisons. The two-

dimensional finite element analyses are carried out at various cross-sections along the 

length of the die in order to compare the maximum deflection occurring at each section 

with the beam theory and three-dimensional finite element analysis predictions.  
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Figure 3.2: Two-Dimensional Finite Element Analysis at the Die Center (Z=0mm) 

Figure 3.2 shows the deformed and the undeformed edges of the die at the center due to 

pressure loading. The maximum deflection of 0.0962 mm occurs at the outer slot exit. 

The two-dimensional finite element analysis also confirms our assumption of considering 

the deflections of the slots to be linear in coupled equations. This can be seen from the 

graph shown below. The assumption is particularly good for the critical outer slot. 

 

Figure 3.3: Slot Deflections along the Working Width at the Die Centre (Z=0mm) 
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V. Two-Dimensional Finite Element Analysis due to Non-Isothermal Loading  

The distortion of the coating die also takes place when the die is at a temperature 

different than that of the coating fluid. Two-dimensional finite element analyses of the 

coating die are carried out to evaluate the temperatures close to which the die shows 

approximately the same amount of deflection as the coating die subjected to pressure 

loading (Appendix G). For the purpose of two-dimensional thermal analysis, a die model 

similar to the pressure loading analysis is considered which is insulated on cantilevered 

edge and the end of the die width. The bottom surface is a constant 20
o
C, and the top 

surface is the temperature of the liquid which is set to different values. The die is 

cantilevered near the inner cavity edge and the thermal loadings as explained above are 

applied to estimate the deflections undergone by the die when subject to non-isothermal 

loading alone. Figure 3.4 shows the nodal temperature distribution within the die when 

the fluid temperature is 22
o
C and the ambient temperature is kept at 20

o
C. The hotter 

liquid opens the slots. 

 

Figure 3.4: Nodal Temperature Distribution at the Die End (Z=1000mm) 

Thermal analyses on the coating die were carried out to estimate the maximum slot 

deflection for different liquid temperatures in order to determine the sensitivity to 
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operating temperatures. It can be seen from the graph below that deflection varies linearly 

with change in temperature. 

 

Figure 3.5: Maximum Deflection at die end (Z=1000mm) Vs Temperature Difference 

The maximum deflections undergone by the coating die when the fluid temperature is 

22
o
C and ambient temperature is 20

o
C at the die length end (z=1000 mm) is 0.0127 mm 

(Figure 3.6) which is close to the pressure loading deflection of 0.0122 mm calculated 

using beam theory.  

 

Figure 3.6: Two-Dimensional Finite Element Analysis at the die end (Z=1000mm) 
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Theoretically, the minimum deflection of the die would occur under isothermal 

conditions. However, in practice it is not possible to maintain a strictly isothermal 

condition during the coating process. The knowledge of the amount deflection undergone 

by the die for a particular change in temperature gives an upper limit to the temperature 

change that can take place within the die body. Although, water jackets are provided 

within the die body in order to achieve an isothermal condition the temperature of the 

feed stream may not match perfectly. Therefore, the sensitivity of a design to temperature 

differences is of considerable interest. 

VI. Three-Dimensional Modeling and Analysis of a Coating Die 

The coating die is modeled three dimensionally with linearly varying inner cavity area, 

referred to as coat-hanger which results in the reduction of its working width but with 

constant aspect ratio along the die length using Pro-Engineer Wildfire 4.0 as discussed in 

Appendix H1.  

 

Figure 3.7: Three-Dimensional Model of a Tapered Coating Die 

The three-dimensional model is saved in Initial Graphics Exchange Specification (IGES) 

format in order to export the part file into ANSYS 12.0. The three-dimensional finite 
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element analysis of the coating die is carried out on the imported model as explained in 

Appendix H2. Only one half of the die is considered for analysis due to its symmetric 

geometry. The pressure distribution for three-dimensional analysis is maintained uniform 

over the cavities and slots for the ease of applying the pressure loading in three 

dimensions. The pressure applied on the inner and outer cavities is 500,000 and 100,000 

Pascal respectively and the average pressure along the inner and outer slot is 300,000and 

50,000 Pascal respectively. The result obtained by this analysis is compared with the two-

dimensional analysis results with the same pressure distribution applied on the three 

dimensional model. 

 

Figure 3.8: Three-Dimensional Finite Element Analysis of the Tapered Coating Die 

The maximum deflection undergone by the coating die during the three-dimensional 

analysis is 0.071865 mm at the center of the die and end of the outer slot and the 

maximum deflection of the die obtained from two-dimensional analysis for the same 

pressure loading using finite element analysis is 0.104 mm at the same location. Figure 

3.9 shows the contour plot of the nodal deflections at the end of the outer slot along one 

half of the die length. The maximum deflection is marked by the red color and occurs at 
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the outer slot and at the center of the die length. The region where the die is cantilevered 

is marked by the blue color and exhibits no deflection. It can also be observed that the 

deflection at the die exit gradually decreases from the die center along the length of the 

die. This behavior is expected since the end of the bar is much stiffer than the center as a 

result of the shorter work width and shallower inner cavity. 

VII. Results 

The maximum deflection which takes place at the die center near the outer slot exit 

obtained from beam theory is 0.08265274 mm. The two-dimensional finite element 

analysis predicts a maximum deflection of 0.0962 mm. The ANSYS gives a higher 

deflection values when compared to beam theory results. 

 

Figure 3.9: Maximum Deflection at Sections along the Die Length 

The three-dimensional analysis carried out with constant pressure loading along the width 

of the cavities and slots is compared with two-dimensional finite element analysis 

predictions with the same pressure loading. From the graph below, it is observed that the 

two-dimensional finite element analysis over predicts the deflection at the center of the 

die. The two-dimensional finite element analysis predictions show a close agreement with 

the three-dimensional analysis results as we move along the die length. 
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Figure 3.10: Maximum Deflection at Sections along the Die Length 

The three-dimensional analysis is carried out with a pressure loading higher than that 

used in beam theory. Hence the three-dimensional coating die will exhibit a maximum 

deflection greater than the actual deflection. It has been observed that maximum 

deflection in a coating die takes place at the die center. The graph below shows that the 

beam theory over predicts the maximum deflection occurring at the die center. 

 

Figure 3.11: Maximum Deflection at Sections along the Die Length 
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Based on this data dies can be designed keeping the deflection obtained by the program 

as an upper limit.  

The simulation program couples the deflection and the flow equations to obtain the 

following results along the length of the coating die. 

1. Deflections undergone at the middle of inner and outer slots 

The graph below shows the slot deflections at the middle. The deflection of the slots 

is maximum at the die center and it gradually decreases as we move along the die 

length. 

 

Figure 3.12: Slot Deflections along the Die Length 

2. Flow rate variations in the slots. 

The coupled analysis estimates the flow rate variation within the slots due to its 

deflection. Since the slot deflection is maximum at the die center, the flow rate 

variation in the slots is also maximum at this section. The variation in flow gradually 

decreases as seen from the graph below due to the decrease in slot deflection. Hence, 

larger the slot deflection, greater will be the flow rate variation. Therefore it is 

essential to keep the slot deflections at a minimum in order to obtain a uniform flow. 
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Figure 3.13: Flow Rate Variation Ratio along the Die Length 

3. Back pressures in the cavities due to the deflection in the slot heights 

The narrow slot heights create a high pressure in the cavities which is referred to as 

the back pressure. The coupled analysis estimates the back pressure created in the 

cavities due to the slot deflection. From the graph below we can see that, the back 

pressure in the cavities is lower at the die center where the slot deflection is 

maximum. The cavity pressure decreases slightly as we move along the die length 

due to reduced slot deflection.  
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Figure 3.14: Cavity Pressures along the Die Length 
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Chapter 4  

I. Design Guidelines 

Die deflection in a coat-hanger type coating die is one of the areas that has not been 

addressed by die designers. When a die deflects, the inner and outer slot heights will 

increase substantially more in the middle of the die than at the ends. The result is that the 

die which was designed for uniform flow will now exhibit heavy flow in the middle. The 

main objective of the coating process is to obtain uniformity in coating film thickness. 

The simulation program based on beam theory is developed to predict the deflection at 

the slot centers along the flow passages and across the length of the coating die. It also 

estimates the back pressure and the flow rate variations in the cavities due to the changes 

in the slot heights. The program treats the die as a non-uniformly loaded beam with 

varying cross sections. The input information to the model is: 

1. The shape and the thickness of the die body 

2. Average flow rate per unit width 

The program calculates the inner and outer slot deflections at their centers, back pressure 

and the flow rate variation ratios in the cavities along the length of the die. An 

optimization routine is carried out using the Solver function, a general purpose 

optimization routine that is available within Excel as an add-in, to determine various 

geometric parameters for the die design which would result in uniform coating thickness 

by reducing deflection and controlling the flow rates. The die dimensions that are found 

to have greatest effect on the deflections are: 

1. Thickness of the die body 

Increasing the thickness of the die reduces the inner and outer slot deflections and 

peak to peak flow rate variation ratios as seen in figures 4.1 and 4.2. However, end 

users want the bar to have minimum weight and cost. Increasing the thickness of the 

bar results in an increase in material cost and weight. Hence a bar with appropriate 

thickness can be chosen by the user which strikes a good balance between the cost, 

weight and the performance of the die. This can be estimated from the simulation 
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program developed in Excel. The thickness of the bar is also a consideration while 

stacking bars used for multi layered coating because the overall size and weight of the 

die is affected. 

 

Figure 4.1: Slot Deflections Vs Thickness of the Coating Die 

2. Working width 

The width of the cavities and slots makes up the working width of the coating die. In 

a coat hanger type die the working width gradually decreases from the center due to 

the tapering of the inner cavity area along the length of the die. The optimization 

routine using Solver in Excel indicates that reducing the working width minimizes the 

slot deflections as seen in figure 4.3. This makes sense because a longer working 

width acts as a lever which results in an increase in the slot deflection leading to non 

uniformity in the flow. 
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Figure 4.2: Slot Deflection Vs Working Width of the Coating Die 

3. Linear reduction in the area of the inner cavity 
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avoid the following occurrences: 

a. Sedimentation of dispersed particulate 

b. Solidification of Non-Newtonian liquids which takes place due to decrease in 

velocity and shear rate 
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Figure 4.4 shows a decrease in the deflection at the center of the slots as the taper is 

reduced at the die center 
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Figure 4.3: Slot Deflections Vs End Inner Cavity Area 

Minimization of the deflection at the middle of the slots induces an increase in the 

back pressure due to the slots. The graph below shows the change in back pressure 

resulting from varying the outer slot height and keeping the inner slot height constant. 

Increasing the height of the outer slot reduces the back pressure exerted on the 

cavities considerably with a small change in the back pressure exerted due to inner 

slot height. 

 

Figure 4.4: Back Pressure in the Cavities Vs Outer Slot Height 
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To obtain a uniform flow across the length of the coating die the back pressure 

developed due to the slot heights needs to be minimized. Hence, during the design of 

the coating die the height of the inner and outer slots should be chosen appropriately 

which reduces the back pressure. For a uniform flow, the outer slot height is kept 

larger than the inner slot height. 

Summary of design guidelines: 

 increase bar thickness to a maximum (consistent with cost and weight constraints) 

 reduce working width to a minimum 

 minimize any inner cavity taper (present for other reasons) 

 maximize slot heights to reduce back pressure 

The advantage of the die model developed is that the Solver optimization routine can 

be used to minimize flow non-uniformity subject to constraints. This approach is very 

efficient compared to trial and error. 

II. Conclusions and Recommendations 

The two-dimensional beam theory is a low load computational model which couples both 

the deflection and flow to give an estimate of the deflection and flow rate variations. The 

estimates obtained from the simulation program can be used by applying a factor of 

safety by the die designers in designing various die parameters for coating process 

involving liquids with different flow rates and viscosities.  

For future work, it is recommended to conduct the three dimensional finite element 

analysis with the pressure loading similar to the beam theory loading in order to get a 

much more accurate comparison between the beam theory and three dimensional finite 

element results. From the thermal analyses conducted on the two dimensional die, it can 

be concluded that small temperature variation within the die, of the order of a couple of 

degree Celsius, can increase the deflection. Hence for future work it is recommended to 

include thermal variation in the die design and simulation process. 

The optimization process performed on the simulation program suggests certain 

guidelines to minimize the die deflection. Some of the guidelines may not satisfy the 
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practical problems faced by the die designer. For example, increasing the thickness of the 

die reduces the maximum deflection; however increasing the thickness of the die also 

increases the cost and weight of the die. Design guidelines also suggest that reducing the 

inner cavity taper minimizes the deflection undergone by the die. The inner cavity is 

tapered to avoid problems such as fluid flow stagnation, sedimentation, solidification of 

Non-Newtonian liquids. A tapered inner cavity also helps in purging at the ends. 

Therefore during the design phase the design guidelines need to be balanced against the 

cost, machining capabilities and practical conditions to enhance coating uniformity. Since 

die design is an optimization problem, a model of low computational load that can be 

combined with an optimization routine like Solver can be very useful. 
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Appendix A 

Bending Moments of a One- Dimensional Beam Model 

This appendix shows the mathematical derivations of obtaining the bending moments at each of 

the six sections of the two dimensional beam (Figure 3.1). 

Bending Moment at Section (1): 

 

Figure A.1: Bending Moment at Section (1) 

Resultant force vector,   ̃   
 

   
    ̃  (A.1) 

For uniformly varying load    
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Substituting equation (A.2) in (A.1) we have, 
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Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 

      ̃  ( ̃     ̃ )  (A.5) 

Substituting equation (A.3) and (A.4) in (A.5) we have, 

     
   

   
  (A.6) 

Considering any Section after Section (1): 

 

Figure A.2: Bending Moment after Section (1) 

Resultant force vector,  ̃   
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Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 
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Substituting equation (A.7) and (A.8) in (A.9) we have, 
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)  (A.10) 



32 

 

Bending Moment at Section (2): 

 

Figure A.3: Bending Moment at Section (2) 

Resultant force vector,   ̃     
(    )

     
 ̃   (A.11) 

Unit vector normal to the contracting surface is given by, 

  ̃        ̃        ̃  (A.12) 

Substituting equation (A.12) in (A.11), 
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Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 
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Substituting equation (A.13) and (A.14) in (A.15) we have, 

     
 

 
 (    )[(    )         ]  (A.16) 
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Considering any Section after Section (2): 

 

Figure A.4: Bending Moment after Section (2) 

Resultant force vector,   ̃     
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Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 

      ̃  ( ̃     ̃ )  (A.19) 

Substituting equation (A.17) and (A.18) in (A.19) we have, 
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Bending Moment at Section (3): 

 

 

Figure 4.5: Bending Moment at Section (3) 

Resultant force vector,  ̃     (    )  ̃ (A.21) 

Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 

      ̃  ( ̃     ̃ )  (A.23) 

Substituting equation (A.21) and (A.22) in (A.23) we have, 
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Considering any Section after Section (3): 

 

Figure 4.6: Bending Moment after Section (3) 

Resultant force vector,   ̃       ̃  (A.25) 

Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 

      ̃  ( ̃     ̃ )  (A.27) 

Substituting equation (A.21) and (A.22) in (A.23) we have, 
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Bending Moment at Section (4): 

 

Figure 4.7: Bending Moment at Section (4) 

Resultant force vector,  ̃     
(    )
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Unit vector normal to the contracting surface is given by, 

  ̃        ̃        ̃  (A.30) 

Substituting equation (A.30) in (A.29), 
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Resultant vector between the resultant force vector and the centroid of the beam, 

  ̃   (
    

 
)  ̃  

 

 
(     )  ̃ (A.32) 

Bending Moment, 
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Substituting equation (A.31) and (A.32) in (A.33) we have, 
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Considering any Section after Section (4): 

 

Figure A.8: Bending Moment after Section (4) 
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Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 
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Substituting equation (A.35) and (A.36) in (A.37) we have, 
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Bending Moment at Section (5): 

 

 

Figure A.9: Bending Moment at Section (5) 

Part (a) 

Resultant force vector,   ̃    
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Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 
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Substituting equation (A.39) and (A.40) in (A.41) we have, 
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Part (b) 

Resultant force vector,  ̃     (    ) ̃  (A.43) 
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Resultant vector between the resultant force vector and the centroid of the beam, 
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Bending Moment, 

       ̃  ( ̃      ̃  )  (A.45) 

Substituting equation (A.43) and (A.44) in (A.45) we have, 
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(    )

 *   
(    )

 
+  

  

   
(    )

  (A.48) 
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Considering any Section after Section (5): 

 

Figure A.10: Bending Moment after Section (5) 

Part (a): 

Resultant force vector,   ̃    
 

   
 ( ̅   )   ̃  (A.49) 

Resultant vector between the resultant force vector and the centroid of the beam, 

  ̃    (     
 

 
  )  ̃  (   

 

 
)  ̃  (A.50) 

Bending Moment, 

       ̃  ( ̃      ̃  )  (A.51) 

Substituting equation (A.49) and (A.50) in (A.51) we have, 

      
  

 
( ̅   ) (     

 

 
  )  (A.52) 

 

Part (b) 

Resultant force vector   ̃        ̃  (A.53) 

Resultant vector between the resultant force vector and the centroid of the beam, 



43 

 

  ̃    (     
 

 
  )  ̃  (   

 

 
)  ̃  (A.54) 

 

Bending Moment, 

       ̃  ( ̃      ̃  )  (A.55) 

Substituting equation (A.53) and (A.54) in (A.55) we have, 

         (     
 

 
  )  (A.56) 

Total bending moment, 

            (A.57) 

     
   

 
(     

 

 
  )  

 ̅  

 
(     

 

 
  ) (A.58) 
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Bending Moment at Section (6): 

 

 

Figure A.11: Bending Moment at Section (6) 

 

Part (a): 

Resultant force vector,  ̃      ̅(    )  ̃ (A.59) 

Resultant vector between the resultant force vector and the centroid of the beam, 

  ̃    
 

 
(    ) ̃  

(     )

 
 ̃  (A.60) 

Bending Moment, 

       ̃  ( ̃      ̃  )  (A.61) 

Substituting equation (A.59) and (A.60) in (A.61) we have, 

      
 ̅

 
(    ) (A.62) 

 

Part (b): 

Resultant force vector,   ̃      ̅   ̃  (A.63) 

Resultant vector between the resultant force vector and the centroid of the beam, 
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  ̃    (    ) ̃  
  

 
 ̃  (A.64) 

Bending Moment, 

       ̃  ( ̃      ̃  )  (A.65) 

Substituting equation (A.63) and (A.64) in (A.65) we have, 

      
 ̅    

 
 (A.66) 

Total bending moment, 

            (A.67) 

     
 ̅

 
[(    )      ] (A.68) 

  



46 

 

Appendix B 

B1: Couette Flow in Slots 

 

Figure B.1: Flow in Slot 

Simplified Navier Stokes equation is given by, 

  
  

  
  

   

      (B.1) 

Integrating above equation twice with respect to dy, 

 
  

  

  

 
            (B.2) 

where C1 and C2 are constants. 

Applying the boundary conditions: at y=0; u=0 and at y=h; u=0 to equation (B.2) we get, 

    
  

  

 

 
  (B.3) 

       (B.4) 

Substituting equations (B.3) and (B.4) in (B.2), 

   
 

  

  

  
(     )  (B.5) 

To obtain pressure gradient, 

 ∫       
 

 
  (B.6) 

x

y
h
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Substituting equation (B.5) in (B.6) we have, 

 
  

  
  

    

    (B.7) 

  



48 

 

B2: Linearized Pressure in the Slots 

 

Figure B.2: Side View of a Coating Die 

Assuming deflection in the slots to be linear the distorted outer slot height is given by, 

           (B.8) 

where,        (       )
 

 
  (B.9) 

From equation (B.7)  

  ( )  
 

    (B.10) 

  (   )  
 

     (B.11) 

Differentiating equation (B.11) with respect to h=<h>, 

 
  (   )

        
  

 

     (B.12) 

Using Taylor series expansion for local linearization, 

  ( )   (   )  
  (   )

        
(     )  (B.13) 

Substituting equations (B.8), (B.11) and (B.12) in (B.13), 

  ( )  
 

     
 

        (B.14) 

 

Substituting equation (B.14) and (B.9) in the pressure gradient in slot equation (B.7) we have, 

P h’

h’m

h̄’

h̄m’
l

<h>
h’1

h’2
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    [  
 *  

  (  
    

 )
 

 
+

   
]  (B.15) 

Integrating equation (B.15) with respect to x and applying the boundary conditions at x=l; P=0, 

pressure at x=0 we have pressure across the outer slot, 

   
     

    *  
   

 

   
+ where,   

  
(  

    
 )

 
 (B.16) 

Similarly, pressure across the inner slot is given by, 

  ̅    
    ̅ ̅

  ̅  *  
  ̅ 

 

  ̅ 
+ where,  ̅ 

  
( ̅ 

   ̅ 
 )

 
  (B.17) 

Therefore, under the assumption of a linear variation in slot height, the pressure drop across the 

slot can be expressed in terms of the deflection at the center of the slot. 
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Appendix C 

C1: Shape Factor of a Circular Pipe 

 

Figure C.1: Flow in a Circular Pipe 

Pressure gradient along the circular pipe is given by, 

  
  

  
 

  

    
   (C.1) 

where λc is called the shape factor because its value depends on the geometric shape of the 

conduit. 

Let us consider the fluid in the cylinder between r and r+∆r from the line down the middle. The 

pressure force maintaining the fluid motion is given by, 

 Net pressure force = 
  

 
       (C.2) 

Balanced force equation is, 

 
  

 
        (    ) 

  

  
(    )      

  

  
    (C.3) 

Dividing the above equation by 2π and rearranging, 

 
 

  
( 

  

  
)  

  

  
   (C.4) 

Differentiating equation (C.4) twice with respect to r and applying the boundary conditions at 

constant C=0, r=R; v(r) =0 we get, 

z

r

R
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  ( )  
  

  

(     )

 
 (C.5) 

Total flow rate, 

   ∫    
 

 
 ( )    (C.6) 

Substituting equation (C.5) in (C.6) and integrating with respect to r, 

  
  

 
 

  
 

  
  

  where,   
      (C.7) 

Comparing equations (C.1) and (C.7), the shape factor is given by 

    
 

 π
              (C.8) 

The circular shape gives the highest possible shape factor and therefore the lowest pressure 

gradient. However, a circular shape is rarely used in coating dies based on other considerations 

such as wanting the entire cavity in a single bar. 
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C2: Continuity Equation at the Inner and Outer Cavities and Slots 

The flow in the inner cavity is both in the transverse as well as in the longitudinal direction as 

shown in figure C.2. 

 

Figure C.2: Continuity at the Inner Cavity and Slot 

The balanced volumetric flow rate equation at the inner cavity and slot is given by, 

  ̅      ̅   ̅    (C.9) 

Rearranging the above equation we obtain the continuity equation at the inner cavity and slot as, 

 
  ̅

  
   ̅ (C.10) 

The outer cavity flow is similar to the inner cavity flow direction and in addition to this it also 

has the fluid entering it from the inner slot as seen in figure C.3. 

 

Figure C.3: Continuity at the Outer Cavity and Slot 

The balanced volumetric flow rate equation at the outer cavity and slot is given below. 

z z+∆z

Q ̄
z+∆z

q̄

∆z

Q ̄
z

z z+∆z

Qz+∆zQz

q̄

∆z

q
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           ̅        (C.11) 

 

Rearranging and substituting equation (C.9) in (C.11) we obtain the continuity equation at the 

outer cavity and slot as, 

 
  ̅

  
 

  

  
     (C.12) 
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C3: Deflection and Flow Coupled Equation for Inner Cavity  

The first of the four equations for coupled flow and deflection follows from the flow equation for 

the inner cavity. 

Flow along the inner cavity is given by, 

  
  ̅

  
 

  ̅

 ̅[ ̅( )] 
   (C.13) 

Flow along the outer cavity is given by, 

  
  

  
 

  

      (C.14) 

Continuity equation at inner cavity and slot, 

  ̅   
  ̅

  
  (C.15) 

Differentiating equation (C.15) with respect to z, 

 
  ̅

  
  

   ̅

   
  (C.16) 

Pressure in the inner slot from equation (B.17), 

  ̅  
    ̅ ̅

  ̅  *  
  ̅ 

 

  ̅ 
+     (C.17) 

Differentiating equation (C.17) with respect to z, 

 
  ̅

  
 

  

  
 

    ̅

  ̅  

  ̅

  
*  

  ̅ 
 

    
+  

    ̅ ̅

  ̅  * 
 

  ̅ 

  ̅ 
 

  
+ (C.18) 

Substituting equation (C.13), (C.14), (C.15) and (C.16) in (C.18), 

  
  ̅

 ̅[ ̅( )] 
 

  

     
    ̅

  ̅  

   ̅

   *  
  ̅ 

 

  ̅ 
+  

    ̅

  ̅  

  ̅

  
*

 

  ̅ 

  ̅ 
 

  
+ (C.19) 
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Dividing equation (C.19) by 
   

      

 
  ̅  

  
*

 ̅

 ̅[ ̅( )] 
 

 

   
+    ̅

   ̅

   
*  

  ̅ 
 

    
+   ̅

  ̅

  
*

 

  ̅ 

  ̅ 
 

  
+  (C.20) 
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C4: Deflection and Flow Coupled Equation for Outer Cavity  

The second of the four equations for coupled flow and deflection follows from the flow equation 

for the outer cavity. 

Flow in the outer cavity is given by, 

  
  

  
 

  

      (C.21) 

Continuity equation at outer cavity and slot is, 

    
  ̅

  
 

  

  
  (C.22) 

Differentiating equation (C.22) with respect to z, 

 
  

  
  

   ̅

    
   

     (C.23) 

Pressure in the outer slot from equation (B.16), 

   
     

    *  
   

 

   
+  (C.24) 

Differentiating equation (C.24) with respect to z, 

 
  

  
 

    

    *
  

  
(  

   
 

   
)  

  

   

   
 

  
+ (C.25) 

Substituting equation (C.21), (C.22) and (C.23) in (C.25) 

 
    

    *( 
   ̅

    
   

   ) (  
   

 

   
)  ( 

  ̅

  
 

  

  
) ( 

 

   

   
 

  
)+  

  

      (C.26) 

Dividing equation (C.26) by 
    

    
 we have, 

 ( 
   ̅

    
   

   ) (  
   

 

   
)  ( 

  ̅

  
 

  

  
) ( 

 

   

   
 

  
)  

     

         (C.27) 
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Appendix D 

D1: Dimensionless Quantities and Groups: 

Dimensionless variable for inner slot height is given by, 

  ̅  
 ̅ 
 

  ̅ 
  (D.1) 

  ̅ 
    ̅   ̅  (D.1a) 

Dimensionless variable for outer slot height is given by, 

    
  
 

   
  (D.2) 

   
        (D.2a) 

Dimensionless variable for volumetric flow rate in inner cavity, 

   
 ̅

    
 (D.3) 

Dimensionless variable for volumetric flow rate in inner cavity, 

   
 

    
 (D.4) 

Dimensionless variable for inner cavity area, 

   
 ̅

  
   (D.5) 

Dimensionless variable for cavity length, 

   
 

 
  (D.6) 

Dimensionless inner cavity group is given by, 

   
  ̅    

   ̅  ̅̅ 
  (D.7) 

 



58 

 

Dimensionless outer cavity group is given by, 

   
      

       (D.8) 

 

Dimensionless slot group is given by, 

   
  ̅   

      
 (D.9) 

Dividing equation (D.1) by (D.6), 

 
 ̅ 

 
 

 ̅ 
  

    
  (D.10) 

Differentiating equation (D.10) with respect to z, 

 
  ̅ 

 

  
 

   

 

  ̅ 

  
  (D.11) 

Dividing equation (D.2) by (D.6), 

 
  

 
 

  
  

    
  (D.12) 

Differentiating equation (D.12) with respect to z, 

 
   

 

  
 

   

 

   

  
  (D.13) 

Dividing equation (D.3) by (D.6), 

 
 

 
 

 ̅

    
  (D.14) 

Differentiating equation (D.14) with respect to z, 

 
  ̅

  
    

  

  
  (D.15) 
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Differentiating equation (D.15) with respect to z, 

 
   ̅

    
   

 

   

     (D.16) 

Dividing equation (D.4) by (D.6), 

 
 

 
 

 

    
  (D.17) 

Differentiating equation (D.17) with respect to z, 

 
  

  
    

  

  
  (D.18) 

 

Differentiating equation (D.18) with respect to z, 

 
   

    
   

 

   

     (D.19) 
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D2: Coupled Inner Cavity Dimensionless Equation 

Deflection and flow coupled equation for inner cavity is from equation (C.20), 

 
  ̅  

  
*

 ̅

 ̅ ̅  
 

   +    ̅
   ̅

   *  
  ̅ 

 

  ̅ 
+   ̅

  ̅

  
*

 

  ̅ 

  ̅ 
 

  
+  (D.20) 

Rearranging equation (D.13), 

  
  ̅   

   ̅  ̅̅ 
 

 ̅  ̅̅ 
 

   ̅  
  ̅   

     ̅

      

      

  ̅

  
  ̅

   ̅

   *  
  ̅ 

 

    
+   ̅

  ̅

  
*

 

  ̅ 

  ̅ 
 

  
+ (D.21) 

Substituting equations (D.1), (D.3), (D.4), (D.5), (D.7), (D.8), (D.9), (D.11), (D.15), (D.16) in 

(D.21), 

  
      ̅

    
       ̅

 
 

    ̅

 

   

   
[    ̅ ]  

    ̅

 
 

  

  

  ̅ 

  
    (D.22) 

Dividing equation (D.15) by
    ̅

 
, 

  
  

       
   

   
[    ̅ ]   

  

  

  ̅ 

  
    (D.23) 
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D3: Coupled Outer Cavity Dimensionless Equation 

Deflection and flow coupled equation for outer cavity from equation (C.27), 

 ( 
   ̅

    
   

   ) (  
   

 

   
)  ( 

  ̅

  
 

  

  
) ( 

 

   

   
 

  
)  

     

          (D.24) 

Substituting equations (D.2), (D.4), (D.8), (D.13), (D.15), (D.16), (D.18), (D.19), in (D.24) 

  
   

 
*
   

    
   

   + [     ]    *
  

  
 

  

  
+ *

 

 

   

  
+  

     

 
    (D.25) 

Dividing equation (D.25) by
   

 
, 

 *
   

    
   

   + [     ]   
   

  
*
  

  
 

  

  
+        (D.26) 
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D4: Linearized Dimensionless Inner and Outer Cavity Equations about Perfect Flow 

Flow in inner cavity can be represented as, 

    ̅      (D.27) 

where f’ represents a small departure. 

Perfect flow distribution in inner cavity is given by, 

  ̅       (D.28) 

Substituting equation (D.28) in (D.27), 

   (   )      (D.29) 

Differentiating equation (D.29) with respect to ξ, 

 
  

  
    

   

  
  (D.30) 

Differentiating equation (D.30) with respect to ξ, 

 
   

    
    

     (D.31) 

Flow in outer cavity can be represented as, 

         (D.32) 

where g’ represents a small departure. When there is perfect flow from the inner slot there is no 

flow along the outer cavity. 

Differentiating equation (D.32) with respect to ξ, 

 
  

  
 

   

  
  (D.33) 

Differentiating equation (D.33) with respect to ξ, 

 
   

    
    

     (D.34) 
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Dimensionless equation for inner cavity is, 

  
  

       
   

   
[    ̅ ]   

  

  

  ̅ 

  
    (D.35) 

Substituting equations (D.29), (D.30), (D.31), (D.32) in (D.35), 

  
 [(   )   ]

        
    

   
[    ̅ ]   

  ̅ 

  
  

   

  

  ̅ 

  
    (D.36) 

Ignoring smaller term we have linearized coupled dimensionless equation for inner cavity as, 

  
 [(   )   ]

  
      

    

   
[    ̅ ]   

  ̅ 

  
    (D.37) 

Dimensionless equation for outer cavity is, 

 *
   

    
   

   + [     ]   
   

  
*
  

  
 

  

  
+        (D.38) 

Substituting equations (D.30), (D.31), (D.32), (D.33), (D.34) in (D.38), 

 *
    

    
    

   + [     ]   
   

  
*(   

   

  
)  

   

  
+         (D.39) 

    

    
    

           

           

     
   

  
  

   

  

   

  
  

   

  

   

  
        (D.40) 

Ignoring smaller terms we have linearized coupled dimensionless equation for outer cavity as, 

 
    

    
    

     
   

  
       (D.41) 
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Appendix E 

E1: Dimensionless Coupled Deflection and Flow Equations for Inner Slot 

The third of the four equations for coupled flow and deflection follows from the flow equation 

for the inner slot. 

Characteristic inner slot pressure is given by, 

  ̅  
     ̅  

  ̅    (E.1) 

Substituting equation (D.15) in (C.10), the continuity equation for inner cavity and slot we have, 

  ̅      
  

  
  (E.2) 

Inner slot pressure is, 

  ̅    
    ̅ ̅

  ̅  *  
  ̅ 

 

  ̅ 
+  (E.3) 

Substituting equations (D.1), (E.1), (E.2) in equation (E.3), 

  ̅     ̅ 
  

  
[    ̅ ] (E.4) 

Substituting equation (D.30), in (E.4) and ignoring smaller terms, 

  ̅     ̅ *    ̅  
   

  
+ (E.5) 
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E2: Dimensionless Coupled Deflection and Flow Equations for Outer Slot 

The last of the four equations for coupled flow and deflection follows from the flow equation for 

the outer slot. 

Characteristic outer slot pressure is given by, 

    
       

      (E.6) 

Substituting equations (D.15) and (D.18) in (C.12), the continuity equation for outer cavity and 

slot we have, 

       *
  

  
 

  

  
+  (E.7) 

Outer slot pressure is, 

   
     

    *  
   

 

   
+  (E.8) 

Substituting equations (D.2), (E.6), and (E.7) in (E.8), 

      *
  

  
 

  

  
+ [     ]  (E.9) 

Substituting equation (D.30), and (D.33) in (E.4) and ignoring smaller terms, 

      *      
   

  
 

   

  
+  (E.10) 

Inner slot deflection is given by, 

Appendix F 

F1: Two-Dimensional Finite Element Analysis due to Pressure Loading using ANSYS 

1. Preferences  → Structural 

2. Preprocessor → Element type → Add/Edit/Delete → Add → Solid → 8 node PLANE 82 

Options → Element Behavior → Plane Strain 

3. Material Properties → Material Models → Structural → Linear → Elastic → Isotropic → 
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Young’s Modulus EX=190GPa 

Poisson’s Ratio PRXY=0.3 

4. Modeling → Create → Key points (KP) 

At (z=0 mm) 

KP1: 0,0,0,   

KP2: 0,0.01,0, 

KP3: 0.025,0.01,0, 

KP4: 0.025,0.03,0, 

KP5: 0.05,0.03,0, 

KP6: 0.06732,0.02,0, 

KP7: 0.08423,0.02,0, 

KP8: 0.09,0.03,0, 

KP9: 0.1,0.03,0,  

 

At (z=500 mm) 

KP1: 0,0,0,  

KP2: 0,0.01268,0, 

KP3: 0.02165,0.01268,0,  

KP4: 0.02165,0.03,0,   

KP5: 0.04665,0.03,0,    

KP6: 0.06397,0.02,0, 

KP7: 0.08088,0.02,0, 

KP8: 0.08665,0.03,0, 

KP9: 0.09665,0.03,0,   

 

At (z=1000 mm) 

KP1: 0, 0, 0   

KP2: 0, 0.01586,0 

KP3: 0.01768, 0.01586,0 

KP4: 0.01768, 0.03,0,   

KP5: 0.04268, 0.03,0 
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KP6: 0.06, 0.02,0 

KP7: 0.0769, 0.02,0 

KP8: 0.08267, 0.03,0 

KP9: 0.09267, 0.03,0 

Create → Lines →Lines → Straight Lines → through key points  

L1:         1,       2 

L2:         2,       3 

L3:         3,       4 

L4:         4,       5 

L5:         5,       6 

L6:         6,       7 

L7:         7,       8 

L8:         8,       9 

L9:         9,      10 

L10:      10,     11 

Create → Areas →Arbitrary → By Lines 

A1: L1, L2, L3, L4, L5, L6, L7, L8, L9, L10 

5. Meshing → Mesh Tool → Fine (1) → Mesh → Pick Areas 

6. Loads-> Define Loads → Apply→ Structural →Displacement → on lines → All DOF → 0 

Pressure: Inner Cavity → 500000 Pa 

Inner Slot → 500000 to 100000 Pa 

Outer Cavity → 100000 Pa 

Outer Slot → 100000 to 0 Pa 

7. Solution → Solve → Current LS 

8. Post Processor → Plot Results→ Contour Plot→ Nodal Solution→ Vector Sum 

Displacement. 

  



68 

 

F2: Two-Dimensional Finite Element Analysis due to Thermal Loading using ANSYS 

1. Preferences  → Thermal 

2. Preprocessor → Element type → Add → Solid → PLANE 77 

Options → Element Behavior → Plane Strain 

3. Material Properties → Material Models → Thermal 

Thermal Conductivity→50 W/mK 

Coefficient of thermal expansion→20E-06 m/m
o
C 

4. Modeling → Create → Key points (KP) 

KP1: 0, 0, 0   

KP2: 0, 0.01586,0 

KP3: 0.01768, 0.01586,0 

KP4: 0.01768, 0.03,0,   

KP5: 0.04268, 0.03,0 

KP6: 0.06, 0.02,0    

KP7: 0.0769, 0.02,0 

KP8: 0.08267, 0.03,0  

KP9: 0.09267, 0.03,0  

Create → Lines →Lines → Straight Lines → through key points  

L1:         1,       2   

L2:         2,       3   

L3:         3,       4   

L4:         4,       5   

L5:         5,       6   

L6:         6,       7   

L7:         7,       8   

L8:         8,       9   

L9:         9,      10   

L10:      10,     11   

Create → Areas →Arbitrary → By Lines 

A1: L1, L2, L3, L4, L5, L6, L7, L8, L9, L10 

5. Meshing → Mesh Tool → Fine (1) → Mesh → Pick Areas  
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Loads→ Define Loads → Apply→ Thermal →On Lines 

Insulated on the sides 

Ambient temperature 20
o
C on the bottom surface 

Fluid temperature 22
o
C on the top surface 

6. Solution →  Solve →  Current LS 

7. Preferences  → Structural and thermal 

8. Preprocessor → Element type→ Switch element type→ Thermal to Structural 

9. Material Properties → Material Models → Structural → Linear → Elastic → Isotropic  

Young’s Modulus EX=190GPa 

Poisson’s Ratio PRXY=0.3 

10. Loads→ Define Loads → Apply→ Structural 

Cantilevered on the left edge 

Thermal loading from thermal analysis results 

11. Solution →  Solve →  Current LS 

12. Post Processor → Plot Results→ Contour Plot→ Nodal Solution→ Vector Sum 

Displacement. 
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Appendix H 

H1: Modeling of the Three-Dimensional Coating Die Using Pro-Engineer 4.0 

1. Start Pro-Engineer Wildfire 4.0 and set the working directory. 

2. Select new file and name the model. This file will be saved in .prt format. 

3. Select blend protrusion tool and then the sketching tool icon. This will switch the screen to 

sketcher mode. Click the reference plane marked as right.  

4. Draw the tapered coating die model on this plane at the center in two dimensional. This 

figure will have an inner cavity depth and width of 20 and 25 mm respectively and a working 

length of 100 mm. Use the toggle tool which will make the figure1 inactive. Draw the second 

figure with inner cavity depth and width of 17.32 mm and 21.65 mm respectively and a 

working length of 96.65 mm. Repeat the toggle step and draw the third figure which will 

have inner cavity depth and width of 14.14 mm and 17.68 mm respectively and a working 

length of 92.68 mm. 

5. Next enter the distance of the figure 2 from figure 1 and figure 3 from figure 2. Pro-E will 

then model a straightly blended three dimensional linearly tapered coating die model.  

6. The three-dimensional model is then saved in IGES format in order to import it into ANSYS 

to carry out the three-dimensional finite element analysis. 

H2: Three-Dimensional Finite Element Analysis of the Coating Die Using ANSYS 12.0 

1. File → Import the IGES file from Pro-E  

2. Preferences  → Structural 

3. Preprocessor → Element type → Add/Edit/Delete → Add → Solid → tetra 10 node 92 

4. Material Properties → Material Models → Structural → Linear → Elastic → Isotropic → 

Young’s Modulus EX=190GPa 

Poisson’s Ratio PRXY=0.3 

5. Meshing → Mesh Tool → Fine (1) → Mesh → Pick All 

6. Loads-> Define Loads → Apply→ Structural → Displacement on inner cavity edge → on 

areas → All DOF → 0 

Symmetric boundary condition on area at the die center 

 



71 

 

Pressure Loadings on areas:   

Inner Cavity → 500000 Pa 

Inner Slot → 350000 Pa 

Outer Cavity → 100000 Pa 

Outer Slot → 50000 Pa 

7. Solution → Solve → Current LS 

8. Post Processor → Plot Results→ Contour Plot→ Nodal Solution→ Vector Sum 

Displacement. 
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